
PLEASE READ:  Important information 
about installing and using this driver!

Before you can produce a plot, you must install and set up this driver software on your hard 
disk using the instructions included in this document. This document also contains plotter- 
and software application-specific information to help you achieve the best quality and 
performance when plotting with this driver.

We strongly recommend that you read this document before proceeding with driver 
installation and set up. In addition to installation (section 1.0) and set up instructions 
(section 2.0), this document includes information about how the driver works with specific 
plotters and software applications (sections 3.1 and 3.2), troubleshooting hints (section 3.3), 
and how to get help if you need it (section 4.0).

NOTE:  This document is also available as a file on your driver disk called "HPDRIVER.WRI." 
You can view the file on your computer screen and you can print it.



Instructions for Installing and Using
The HP Plotter Driver (HP-GL/2 and HP RTL)

for Microsoft® Windows 3.0/3.1   (v1.1)
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Introduction
This driver supports the following HP plotters:

Plotter Name Model Number
HP DesignJet Plotters C1633A, C1633B
HP DesignJet 600 Plotters C2847A, C2848A
HP DesignJet 650C Plotters C2858A, C2859A
HP DraftMaster SX Series Plotters 7595B, 7595C
HP DraftMaster RX/MX Series Plotters 7596B, 7596C/7599A, 7599B
HP DraftPro Plus Plotters C3170A, C3171A
HP 7550B Graphics Plotter1 7550B
HP 7600 Series Plotters1 240D, 240E, 250, 255, and 355
1   If you're using one of these plotters, choose "Hewlett-Packard HP-GL/2 Plotter" as 
your plotter during driver installation.

Although there are older plotter drivers with similar names, please note that in the 
Windows 3.0/3.1 environments you should only use this driver to plot with the devices 
listed above (with the one exception noted below). Older drivers use a less-efficient 
graphics language and have limited features and settings.

Note to AutoCADTM Release 11/12 for Windows users  

The only exception to the above paragraph is that we don't recommend using this 
Hewlett-Packard driver when you're running AutoCAD Release 11/12 for Windows. 
Instead, use the Autodesk driver that was automatically loaded when you installed 
AutoCAD. Refer to section 3.2.1, "AutoCAD Release 11/12 for Windows users: use the 
Autodesk driver instead of this one," to verify that you're using the recommended driver.
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1.0   Installing the driver software
1.1  Which installation method should you use?

There are two ways to install this driver software on your computer:
> Use the driver's quick "install" program,

OR
> Use the standard Windows method.
We recommend using the driver's "install" program, which is the fastest installation 
method. The "install" program also automatically increases the Transmission Retry 
to 900 seconds. This increase is necessary to ensure that you'll be able to plot 
complex drawings or text, which can take a long time to be transmitted from your 
computer to your plotter.
If you prefer to use the standard Windows method, refer to the following sections in 
your Microsoft Windows User's Guide:  "Installing a Printer Driver Not Supplied with 
Windows" and "Selecting a Printer Port."  You can find these instructions in Chapter 
5 of the Windows 3.0 edition, and in Chapter 6 of the Windows 3.1 edition. 
If you use the standard Windows method, you'll need to manually increase the 
Transmission Retry to 900 seconds. To access this setting in Windows 3.0, choose 
Control Panel, Printers, then Configure. In Windows 3.1, choose Control Panel, 
Printers, then Connect.

1.2  Installing with the driver's quick "install" program 
(recommended method)
During installation you must have at least 2 MB of disk space available on your hard
drive. We also recommend using a 386- or 486-based computer with at least 2 MB 
of RAM.

Step 1. With the driver disk inserted in your floppy drive and with Microsoft 
Windows running, select Run from the File menu (in the Windows Program 
Manager).

Step 2. In the Command Line box, type "b:\install" (or substitute the name of the 
floppy drive containing your disk for "b"), then click the OK button to 
continue.

NOTE: If you don't have at least 2 MB of available hard disk space, you 
will get an error message at this point. Clear some hard disk space 
on your computer, then restart the installation at Step 1.
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Step 3. When the "Hewlett-Packard HP-GL/2 Plotter Driver Installer" dialog box is 
displayed, enter the appropriate settings (described below) for your plotter.

Plotter:Select your plotter from this drop-down list box. The HP DesignJet 
plotter is the default device.

NOTE: Select "Hewlett-Packard HP-GL/2 Plotter" only if you have 
one of the following plotters:

HP 7550B Graphics Plotter
HP 7600 Series Plotter

Port: Select your plotter's port from this drop-down list box. LPT1 is the 
default port.

NOTE: Be sure to choose the correct port here (the one you'll be 
using with the selected plotter), before completing the set
up instructions later in this document. The driver settings 
are saved with the selected Port name, so if you change 
the port after setting up, you'll be starting over with the 
driver's default settings.

Use Print Manager:  When this check box is selected (default, an "X" 
appears in it), the Windows Print Manager controls printing in the 
background while you continue to work with your software 
applications in the foreground. 

When this check box is deselected (no "X"), your software 
application plots directly to your local plotter or to the network 
(without using the Windows Print Manager). If you plot without 
Print Manager, you can't work with your computer until your file is 
completely delivered to the network plotter or until it finishes 
plotting on your local plotter.

Set As Default Printer:  When this check box is not selected (default, no 
"X"), the default output device in the Printers dialog box will not be
changed. 

When this check box is selected (an "X" appears in it), the plotter 
chosen in the above Plotter drop-down list box will be set as 
the default output device in the Printers dialog box in the Windows 
Control Panel.

Step 4. Click the OK button to begin installation. The installation process takes less 
than a minute. The Copying File box shows the files being transferred to 
your hard disk.
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Step 5. When installation of your selected plotter is complete, one of the following 
things will happen, depending on which version of Windows you're running:

> If you're running Windows 3.0, a message box tells you that the 
driver has been installed successfully. Click OK, then remove the driver 
installation disk and continue with the instructions in the next section 
on setting up the driver.

OR

> If you're running Windows 3.1, you'll be asked if you want to install 
another plotter (click Install) or complete the installation (click Done). If
you click Install, continue from Step 3. If you click Done, a message 
box tells you that the driver has been installed successfully. Click OK, 
then remove the driver installation disk. Continue with the instructions 
in the next section on setting up the driver.
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2.0  Setting up the driver software
This section contains a detailed description of the plotter driver's settings, which can be 
changed by accessing several dialog boxes. 

There are two different sets of instructions: section 2.2, "Setting up with Windows 3.0 
applications (and Windows 3.1 applications without the Windows Print Setup dialog 
box)," and section 2.3, "Setting up with Windows 3.1 applications that use the Windows 
Print Setup dialog box."

If you're running Windows 3.0, you should always use the set up instructions in section 
2.2.

If you're running Windows 3.1, it's important for you to read the following section, 
"Which set up instructions should you use? (For Windows 3.1 users only)," to determine 
which set up instructions to use. 

The terms "local" and "global" are used throughout this section to describe the effect of 
changing the driver settings. When the term local is used, it means that changing the 
driver setting affects only the current software application (the one from which you're 
viewing the driver setting). When changing a driver setting has a global effect, all 
currently-running applications are affected by the change.

If you find that you have questions or need help during the set up process, refer to 
section 4.0, "Getting help," near the end of this document.

2.1  Which set up instructions should you use? (For Windows 3.1 
users only)

Here's why you need to decide which section to use:

1) Windows 3.1 dialog boxes have many distinct differences from those in 
Windows 3.0.

AND

2) If you're running Windows 3.1 with a software application that wasn't created 
with an important Windows 3.1 feature - the use of the Windows Print Setup 
dialog box that lets you make local (vs. global) changes to your driver settings -
your driver dialog boxes and settings will look virtually the same as if you were 
running Windows 3.0. 
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If you're running Windows 3.1, perform this quick test now to determine if the 
application you'll be plotting from has the Windows Print Setup dialog box. 

NOTE: This test is the only way we've found to determine which dialog boxes will 
be displayed, and therefore, which driver set up instructions Windows 3.1 
users should use. The version number and release date of your software 
application do not accurately predict whether or not the application has the
Windows Print Setup dialog box. 

Step 1. From within your software application (important!), and with your HP plotter
selected as the output device, display the dialog box your application uses 
to set up output devices for printing. 

Every software application has a different access method, so you may need
to refer to your application's user guide to locate this dialog box. Generally,
you can access this dialog box from the File menu in your application by 
first choosing Print, Print Setup, or Printer Setup, then clicking the Setup 
button. 

Step 2. Determine which one of the two dialog boxes is displayed: the Windows 
Print Setup dialog box or the driver's Setup dialog box.

The title bar of the Windows Print Setup dialog box says "Print Setup." The 
Print Setup dialog box has the following settings (and sometimes other 
settings as well): Default Printer, Specific Printer, Orientation, Paper Size, 
and Paper Source.

The title bar of the driver's Setup dialog box says "Setup: (plotter name) on
(port name)." The Setup dialog box has these settings: Media Size, Media 
Source, Print Quality, Orientation, and Copies.

Now refer to the following recommendations on which driver set up instructions to 
use. Use one set or the other, not both sets of instructions.

> If the Print Setup dialog box was displayed when you ran the above test, 
use the instructions in section 2.3, "Setting up with Windows 3.1 applications 
that use the Print Setup dialog box."

OR

> If the Setup dialog box was displayed instead, use the instructions in 
section 2.2, "Setting up with Windows 3.0 applications (and Windows 3.1 
applications without the Print Setup dialog box)."

11



2.2  Setting up with Windows 3.0 
(and Windows 3.1 applications without the Windows Print 
Setup dialog)
There are three dialog boxes associated with this driver:  Setup, User-defined Size, 
and Options. Each dialog box has several user-changeable settings that you may 
want to change, depending on your particular driver set up needs. Use the following
procedure for driver setup:

Step 1. Read through the first few paragraphs in sections 2.2.1, 2.2.2, and 2.2.3, 
which describe the three dialog boxes.

Step 2. Follow the instructions for accessing each of the three dialog boxes.

Step 3. When you've displayed a dialog box on your computer screen, make a note 
of the settings in that dialog box you want to change.

Step 4. Read through the parts of this section that describe the settings you want 
to change, then make the appropriate changes. For example, if you want to
change the Media Size setting in the Setup dialog box, refer to section 
2.2.1.2.2, "Media Size."  

NOTES: 1) Changing any of the settings in these dialog boxes has a global effect on
all currently-running applications. 2) If you assign your plotter to a different
port, you'll need to reset the driver settings.

2.2.1  Setup dialog box

This is the main dialog box you'll use for the set up process. This dialog box also
gives you access to two other dialog boxes, User-defined Size (through an 
option in the Media Size drop-down list box) and Options (through the Options 
button), which are described in subsequent sections.
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2.2.1.1  Accessing

You can access this dialog box from within your software application, or 
from the Windows desktop. Here's how:

> From within your application, try choosing Print, Print Setup, or Printer 
Setup from the File menu, then try clicking the Setup button. This 
procedure is application-specific.
OR

> From the Windows 3.0 desktop, choose the Control Panel, choose 
Printers, click the Configure button, then click the Setup button.

OR

> From the Windows 3.1 desktop, choose the Control Panel, choose 
Printers, then click the Setup button.

2.2.1.2  Changing the settings

This dialog box has six settings: Plotter Type, Media Size, Media Source, 
Print Quality, Orientation, and Copies.

2.2.1.2.1  Plotter Type

The Plotter Type setting indicates the selected plotter.

To change the Plotter Type setting, highlight another selection in the 
drop-down list box. The setting that's selected the first time you access
this dialog box (after installing the driver) reflects the plotter choice 
you made during installation. 

NOTE: If you're running Windows 3.1, there's no Plotter Type setting. 
You can change the selected plotter by choosing another 
Default Printer in the Printers dialog box in the Windows 
Control Panel. If you want to use an HP plotter not listed in the 
Printers dialog box, run the driver's install program again and 
install the new plotter. Refer to section 1.2, "Installing with the
driver's quick install program (recommended method)," for 
installation instructions.
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2.2.1.2.2  Media Size

The Media Size setting indicates the size of the media you've loaded in 
the plotter. The default Media Size is "ANSI A 8 1/2 x 11 in." Several 
other standard-size options are included, plus a "User-defined" option. 

NOTE: If you're using an HP 7550B Graphics plotter, you should only 
choose from the following Media Sizes: ANSI A, ANSI B, ISO A3,
and ISO A4. 

To change the Media Size setting, highlight another option in the drop-
down list box. 

NOTE: You must select a Media Size regardless of whether you have a
sheet or a roll loaded.

Choose the "User-defined" option if the dimensions of the media you've
loaded are not listed among the Media Size settings, or if you want to 
produce a long-axis plot (refer to section 3.2.4, "Long-axis plotting," for
more information). When you select the "User-defined" option, the 
User-defined Size dialog box will be displayed. Refer to section 2.2.2, 
"User-defined Size dialog box," for more information.

Driver Media Size vs. Application Drawing Size

The Media Size setting in the plotter driver interacts with the drawing 
size settings in your software application to determine how your 
plotted output will look. Drawing size is usually determined by one or 
more settings in your software application, such as "Size" and "Scale," 
through a Page Setup or similarly-named command in the File (or 
other) menu. While Media Size indicates the physical dimensions of the
media you're plotting with, drawing size controls where your drawing 
will appear within the confines of the indicated Media Size.

It's important that the driver's Media Size setting and the application's 
drawing size setting are exactly the same. Read the examples below to
understand what happens under different circumstances. 

NOTE: There's one exception to the following examples. If you're 
using an HP DesignJet 600 or 650C plotter with the Inked Area 
feature selected (default), your plots will be truncated at the 
end of the inked area of the drawing with only the margin 
added; the selected media size - whether specified in the 
driver or in the application - will have no affect on the actual 
plot size. For example, if your drawing has an inked area of 4.5
inches and 1-inch margins all around, the resulting plot will be 
6.5 inches long.
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Example 1:  If you set Media Size to "ANSI A 8 1/2 x 11 in," and set the 
drawing size to 8 1/2 x 11 inches in your application, your 8 1/2 x 11-
inch drawing will be plotted in the center of the A-size media.

Example 2:  If you set Media Size to "ANSI E 34 x 44 in," and set the 
drawing size to  8 1/2 x 11 inches in your application, your 8 1/2 x 11-
inch drawing will be plotted in one corner of the E-size media.

Example 3:  If you set Media Size to "ANSI A 8 1/2 x 11 in," and set the 
drawing size to 11 x 17 inches in your application, your 11 x 17-inch 
drawing will be clipped to the  8 1/2 x 11-inch Media Size. 

NOTES: 1) Some applications use different margin settings than this 
driver, which could result in your plots being clipped even 
though you've chosen the same drawing size and Media Size. 
If you have this problem, do one of the following: a) adjust 
your application's margin settings (if the application allows) to 
match the driver's margin settings for your plotter selection 
(refer to section 3.1.2, "Plotter margin settings using this 
driver") or b) scale down the size of the drawing in your 
application, or c) increase the Media Size driver setting and 
load a larger media size.

2) Some applications have a maximum plot size limit. If 
your application has such a limit, your drawing will be 
truncated at the limiting dimensions. For example, CorelDRAW 
limits drawings to 18.0 x 18.0 inches (457 x 457 mm); if you 
specify a larger Media Size in the driver - "ANSI E 34 x 44 in," 
for example - your 18.0 x 18.0-inch drawing will be plotted in 
one corner of the E-size media.

2.2.1.2.3  Media Source

The Media Source setting indicates whether you've loaded a single 
sheet or a roll of media in your plotter, and if a roll, the width.

To change the Media Source setting, highlight another selection in the 
drop-down list box. For example, if you've loaded an E-size roll, select 
"36 inch Roll."

NOTES: 1) If you've loaded a roll size that isn't displayed, choose 
"Sheet."

2) You must select a Media Source regardless of whether 
you have a sheet or a roll loaded.
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2.2.1.2.4  Print Quality

The Print Quality setting indicates the quality level at which your plots 
will be produced (i.e., Draft, Final, or Enhanced). The Enhanced quality 
level is only available when one of the HP DesignJet 600 or 650C 
plotters is selected.

To change the Print Quality setting, highlight another selection in the 
drop-down list box.

HP DesignJet, DesignJet 600, and DesignJet 650C Users

Each time you send a plot, the plotter's front panel quality level is 
changed to match this Print Quality setting. This means that anyone 
who 1) is networked to your plotter and 2) doesn't have a plotter driver
with a print quality setting will be affected by the front panel change 
caused by your plot. To avoid this problem, the affected users should 
always check the plotter's front panel quality level before plotting.

HP DraftMaster and DraftPro Plus Users

The driver's Final quality level corresponds to the Quality print quality 
level in these plotters.

HP 7600 Series Users

When using the 240D and 240E models, there's no difference between 
the Draft and Final quality levels.

2.2.1.2.5  Orientation

The Orientation setting indicates which way the Media Size you've 
selected will be oriented: portrait or landscape. Portrait means the 
Media Size is taller than it is wide when you view the plotted drawing 
upright. Landscape means the Media Size is wider than it is tall when 
you view the plotted drawing upright. 

To change the Orientation setting, click the option button you want. 
The icon to the left of the option buttons illustrates the selected 
Orientation.

NOTES: 1) Some applications include their own orientation setting that
overrides the driver's Orientation setting. Check to see if your 
application has an orientation setting, and be sure that the 
driver's orientation setting always matches it. 

2) When you want to produce a landscape-oriented plot using 
the largest size media your plotter supports, you'll need to 
change the margin settings for your plotter type. Refer to 
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section 3.1.2.1 for instructions.
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2.2.1.2.6  Copies

The Copies setting allows you to produce up to 99 plots of each 
drawing. To change the Copies setting, type in a new number between 
1 and 99, inclusive.

2.2.2  User-defined Size dialog box

Use this dialog box instead of the other Media Size options in the Setup dialog 
box when: 

> The dimensions of the media you've loaded are not listed among the Media
Size options,

OR

> You want to produce a long-axis plot. (Refer to section 3.2.4, "Long-axis 
plotting," for more information.)

2.2.2.1  Accessing

To access this dialog box, select "User-defined" from the Media Size drop-
down list box in the previously-described Setup dialog box.

2.2.2.2  Changing the settings

This dialog box has three settings: Units, Length, and Width.

When entering Width and Length values, refer to the following table for the 
range of acceptable values (inclusive), which are based on the plotter type 
you selected in this driver. The Length setting must always be greater than 
or equal to the Width setting.
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Driver-selected Width Length
Plotter Type1 Range Range2

HP DesignJet Plotters 8.3 to 36.1 in 8.3 to 109.2 in
(211 to 917 mm) (211 to 2773 mm)

HP DesignJet 600 Plotter (C2847A) 8.3 to 24.6 in 8.3 to 109.2 in
(211 to 625 mm) (211 to 2773 mm)

HP DesignJet 600 Plotter (C2848A) 8.3 to 36.1 in 8.3 to 109.2 in
(211 to 917 mm) (211 to 2773 mm)

HP DesignJet 650C Plotter (C2858A) 8.3 to 24.6 in 8.3 to 109.2 in
(211 to 625 mm) (211 to 2773 mm)

HP DesignJet 650C Plotter (C2859A) 8.3 to 36.1 in 8.3 to 109.2 in
(211 to 917 mm) (211 to 2773 mm)

HP DraftMaster Plotters (all) 8.2 to 36.5 in 8.2 to 109.2 in
(208 to 927 mm) (208 to 2773 mm)

HP DraftPro Plus Plotter (C3170A) 8.2 to 25.0 in 8.2 to 63.0 in
(208 to 635 mm) (208 to 1600 mm)

HP DraftPro Plus Plotter (C3171A) 8.2 to 36.2 in 8.2 to 63.0 in
(208 to 919 mm) (208 to 1600 mm)

Hewlett-Packard HP-GL/2 Plotter8.3 to 36.1 in 8.3 to 109.2 in
(211 to 917 mm) (211 to 2773 mm)

1  If you're using an HP 7550B Graphics plotter, you should only choose from the following 
Paper Sizes: ANSI A, ANSI B, ISO A3, and  ISO A4.
2  If your application has a maximum length value, your plots will be limited to that value even
if you enter a higher Length value in the driver.
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2.2.2.2.1  Units

The Units setting indicates the units of the Length and Width 
dimensions you will enter (see below).

To select a Units setting, click the option button you want (millimeters 
or inches).

2.2.2.2.2  Width

The Width setting indicates either the width (shorter dimension) of the 
custom-size media you've loaded, or the width of the media you've 
loaded for a long-axis plot. 

To enter the Width setting, type a number in the units you selected 
above.

NOTE: Always enter the shorter dimension for Width.

2.2.2.2.3  Length

The Length setting indicates either the length (longer dimension) of the
custom-size media you've loaded, or the length you want your long-
axis plot to be.

To enter the Length setting, type a number in the units you selected 
above.

NOTE: Always enter the longer dimension for Length.

2.2.3  Options dialog box

This dialog box is device-specific. If your selected Plotter Type in the Setup 
dialog box is one of the following devices (also called thermal inkjet or TIJ), you 
can lighten or darken your plotted output with the Darkness setting. 

TIJ devices: HP DesignJet Plotter
HP DesignJet 600 Plotter (C2847A)
HP DesignJet 600 Plotter (C2848A)
HP DesignJet 650C Plotter (C2858A)
HP DesignJet 650C Plotter (C2859A)

NOTE: The TIJ devices listed above don't have pen parameter settings in the 
driver because they don't have pens in a carousel (they have pen 
cartridges) and they don't have the ability to plot in color. However, the
TIJ plotters can convert color in raster images to grayscale values. 
Refer to sections 3.1.3, "HP DesignJet plotter notes," and 3.1.4, "HP 
DesignJet 600 plotter notes," for more information.
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If your selected Plotter Type is one of the remaining devices below, the Options 
dialog box lets you change the Pen Number, Color, and Type settings.

Non-TIJ devices: HP DraftMaster SX Series
HP DraftMaster RX/MX Series
HP DraftPro Plus Plotter (C3170A)
HP DraftPro Plus Plotter (C3171A)
Hewlett-Packard HP-GL/2 Plotter

Refer to the appropriate section below for your selected Plotter Type.

2.2.3.1  Options dialog box for TIJ devices

To access the Options dialog box, click the Options button in the previously-
described Setup dialog box. (Refer to section 2.2.1.1, "Accessing," for 
instructions on accessing the Setup dialog box.)

2.2.3.1.1  Darkness

The Darkness setting controls the lightness or darkness of your plotted 
output. You might find this setting useful if you're working with a 
scanned image in your application.

The default Darkness setting is in the middle of the intensity bar. To 
choose another setting, click on another spot to the left (lighter) or 
right (darker) of the middle setting. There are five Darkness setting 
choices. To restore the default setting, click the Default button.

2.2.3.2  Pen Options dialog box for non-TIJ devices

To access the Options dialog box, click the Options button in the previously-
described Setup dialog box.

Before using the settings in this dialog box, you may want to refer to your 
plotter's user guide for a table of pen colors and types available for your 
plotter type and media type (e.g., paper, vellum, polyester film).

This driver offers 8 Pen Numbers, 10 Colors, and many pen Types to choose
from. The first time you open this dialog box, the default pen settings listed
in the following table will be displayed. If you want to recover the defaults 
at any time after changing the pen settings, click the Default button.
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Pen Number Color Type
1 Black P.3
2 Blue P.3
3 Red P.3
4 Green P.3
5 Orange P.3
6 Brown P.3
7 Yellow P.3
8 Violet P.3

2.2.3.2.1  Pen Number 

Select a Pen Number to change its Color and/or Type. Or select multiple
Pen Numbers to change more than one Pen Number to the same Color 
or Type. 

To select a Pen Number, click it. If you click another Pen Number, the 
first one will remain selected. To deselect a Pen Number, click it again. 

2.2.3.2.2  Color

The Color setting lets you select a new color for the highlighted Pen 
Number(s).

To change the Color setting, choose a new one from the Color menu. 
Choose from Black, Blue, Red, Green, Orange, Brown, Yellow, Violet, 
Red-violet, and Aqua.

Colors that aren't available for the selected pen Type are grayed, and 
can't be selected. When changing a pen's Color and Type, you may 
need to change the Type setting first.

How Color-Mapping Works

To decide which Pen Number will be selected for plotting, the driver 
compares the HLS (Hue, Lightness, and Saturation) value of the colored
object in your application to the HLS values of the driver's pen Colors. 
The colored object will be plotted with the driver pen Color that has the
closest HLS value. The plotted color may be very different from the 
color you've selected in your application because 1) the driver has only
a few colors to select from, and 2) some applications don't accurately 
display the colors you've selected in your drawing.
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HP 7600 Series Users

For best color-mapping results, we recommend the following: 1) select 
"Plotter" (not "Software") as the source of pen parameters on the 
plotter's front panel, 2) define a new front panel pen palette with 8 
pens and choose from the front panel Color Numbers listed below, and 
3) assign the same Pen Number/Color settings to this driver, e.g. if Pen 
Number 1 on the front panel is assigned to front panel Color Number 3 
(green), be sure that Pen Number 1 in the driver is also assigned to the
driver's Color green. 

Recommended  
7600 Front Panel Equivalent Driver's
Color Numbers Driver Color RGB Value
1 Black 0,0,0
2 Red 255,0,0
3 Green 0,255,0
4 Yellow 255,255,0
5 Blue 0,0,255
6 Red-violet 255,0,255
7 Aqua0,255,255
165 Brown 255,192,0
474 Orange 255,128,0
518 Violet 128,0,255

2.2.3.2.3  Type

The Type setting lets you choose a new type for the selected Pen 
Number(s).

To change the Type setting, choose a new one from the Type menu. 

Types that aren't available for the selected pen Color are grayed, and 
can't be selected. When changing a pen's Color and Type, you may 
need to change the Color setting first.

HP 7600 Series Users

The Type setting has no effect on these plotters.
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2.3Setting up with Windows 3.1 applications that use the 
Windows Print Setup dialog box
There are five dialog boxes associated with this driver: Print Setup, Print, Setup, 
User-defined Size, and Options. Each dialog box has several user-changeable 
settings that you may want to change, depending on your particular driver set up 
needs. Use the following procedure for driver setup:

Step 1. Read through the first few paragraphs in sections 2.3.1, 2.3.2, 2.3.3, 2.3.4, 
and 2.3.5, which describe the five dialog boxes.

Step 2. Follow the instructions for accessing each of the five dialog boxes.

Step 3. When you've displayed a dialog box on your computer screen, make a note 
of the settings in that dialog box you want to change.

Step 4. Read through the parts of this section that describe the settings you want 
to change, then make the appropriate changes. For example, if you want to
change the Paper Size setting in the Print Setup dialog box, refer to section 
2.3.1.2.4, "Paper Size." 

NOTE: If you assign your plotter to a different port, you'll need to reset the driver 
settings.

2.3.1  Print Setup dialog box

This is the main dialog box you'll use for the set up process. The settings in this 
dialog box are local, so changing them won't affect other applications.

This dialog box also gives you access to the Options dialog box (through the 
Options button), which is described in a subsequent section.

2.3.1.1  Accessing

To access this dialog box from within your application, try choosing Print, 
Print Setup, or Printer Setup from the File menu, then try clicking the Setup 
button. This procedure is application-specific, so you may need to consult 
your application's user guide.

2.3.1.2  Changing the settings

This dialog box has four settings: Default Printer, Specific Printer, 
Orientation, and Paper Size. 

NOTE: When setting up with this dialog box, you'll also need to select a 
Media Source in the Setup dialog box as described in section 
2.3.3.2.2, "Media Source."
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2.3.1.2.1  Default Printer

The Default Printer setting indicates the default plotter selected in the 
Windows Control Panel. The current setting is shown in parentheses.

If you want to plot using the current default plotter, click the Default 
Printer option button. 

If you want to change the default plotter to another device (which will 
affect all of your currently-running applications), change it in the 
Printers dialog box; to access the Printers dialog box, select Printers 
from the Windows Control Panel.

2.3.1.2.2  Specific Printer

The Specific Printer setting indicates the plotter selected for the 
current application. 

To select the Specific Printer setting (instead of the Default Printer 
setting), click the Specific Printer option button. To change the Specific 
Printer setting, select another plotter name from the drop-down list 
box.

2.3.1.2.3  Orientation

The Orientation setting indicates which way the Paper Size (see below) 
you select will be oriented: portrait or landscape. Portrait means the 
Paper Size is taller than it is wide when you view the plotted drawing 
upright. Landscape means the Paper Size is wider than it is tall when 
you view the plotted drawing upright. 

To change the Orientation setting, click the option button you want. 
The icon to the left of the option buttons shows the selected 
orientation.

NOTES: 1) Some applications include their own orientation setting that
overrides the driver's Orientation setting. Check to see if your 
application has an orientation setting, and be sure that the 
driver's orientation setting always matches it. 

2) When you want to produce a landscape-oriented plot 
using the largest size media your plotter supports, you'll need 
to change the margin settings for your plotter type. Refer to 
section 3.1.2.1 for instructions.
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2.3.1.2.4  Paper Size

The Paper Size setting indicates the size of the media you've loaded in 
the plotter. The default Paper Size is "ANSI A 8 1/2 x 11 in." Several 
other standard-size options are included, plus a "User-defined" option. 

NOTE: If you're using an HP 7550B Graphics plotter, you should only 
choose from the following Paper Sizes: ANSI A, ANSI B, ISO A3, and ISO 
A4.

To change the Paper Size setting, highlight another option in the drop-
down list box. 

NOTE: You must select a Paper Size regardless of whether you have a
sheet or a roll loaded.

Choose the "User-defined" option if the dimensions of the media you've
loaded are not listed among the Paper Size settings, or if you want to 
produce a long-axis plot (refer to section 3.2.4, "Long-axis plotting," for
more information). Refer to section 2.3.4, "User-defined Size dialog 
box," for instructions on changing the "User-defined" setting.

Driver Paper Size vs. Application Drawing Size

The Paper Size setting in the plotter driver interacts with the drawing 
size settings in your software application to determine how your 
plotted output will look. Drawing size is usually determined by one or 
more settings in your software application, such as "Size" and "Scale," 
through a Page Setup or similarly-named command in the File (or 
other) menu. While Paper Size indicates the physical dimensions of the 
media you're plotting with, drawing size controls where your drawing 
will appear within the confines of the indicated Paper Size.  

It's important that the driver's Paper Size setting and the application's 
drawing size setting are exactly the same. Read the examples below to
understand what happens under different circumstances.

NOTE: There's one exception to the following examples. If you're 
using an HP DesignJet 600 or 650C plotter with the Inked Area 
feature selected (default), your plots will be truncated at the 
end of the inked area of the drawing with only the margin 
added; the selected media size - whether specified in the 
driver or in the application - will have no affect on the actual 
plot size. For example, if your drawing has an inked area of 4.5
inches and 1-inch margins all around, the resulting plot will be 
6.5 inches long.

Example 1:  If you set Paper Size to "ANSI A 8 1/2 x 11 in," and set the 
drawing size to 8 1/2 x 11 inches in your application, your 8 1/2 x 11-
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inch drawing will be plotted in the center of the A-size media.
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Example 2:  If you set Paper Size to "ANSI E 34 x 44 in," and set the 
drawing size to 8 1/2 x 11 inches in your application, your 8 1/2 x 11-
inch drawing will be plotted in one corner of the E-size media.

Example 3:  If you set Paper Size to "ANSI A 8 1/2 x 11 inches" and set 
the drawing size to 11 x 17 inches in your application, your 11 x 17-
inch drawing will be clipped to the 8 1/2 x 11-inch Paper Size. 

NOTES: 1) Some applications use different margin settings than this 
driver, which could result in your plots being clipped even 
though you've chosen the same drawing size and Paper Size. If
you have this problem, do one of the following: a) adjust your 
application's margin settings (if the application allows) to 
match the driver's margin settings for your plotter selection 
(refer to section 3.1.2, "Plotter margin settings using this 
driver") or b) scale down the size of the drawing in your 
application or c) increase the Media Size driver setting and 
load a larger media size.

2) Some applications have a maximum plot size limit. If your 
application has such a limit, your drawing will be truncated at 
the limiting dimensions. For example, CorelDRAW limits 
drawings to 18.0 x 18.0 inches (457 x 457 mm); if you specify 
a larger Media Size in the driver - "ANSI E 34 x 44 in," for 
example - your 18.0 x 18.0-inch drawing will be plotted in one 
corner of the E-size media.

2.3.2.  Print dialog box

There are only two driver-related settings in this dialog box: Copies and Print 
Quality; any other settings that appear in this dialog box are related to and 
controlled by your software application. The Copies and Print Quality settings 
are local.

NOTE: Some applications don't have this Print dialog box. If your application 
doesn't have it, refer to section 2.3.3, "Setup dialog box," for 
instructions on changing the Print Quality and Copies settings.

2.3.2.1  Accessing

To access this dialog box from within your software application, choose 
Print from the File menu.

2.3.2.2  Changing the settings

Although this dialog box may contain several settings, only two of them are
related to this driver: Print Quality and Copies. Therefore, they are the only 
settings discussed here.
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2.3.2.2.1  Print Quality

The Print Quality setting indicates the quality level at which your plots 
will be produced. The supported plotters have Draft, Final, and 
Enhanced quality levels available; you'll notice, however, that the 
application-controlled Print Quality options are different, usually Draft, 
Low, Medium, and High. Here's how these settings "map" to the actual 
plotter quality levels:

Print dialog box Equivalent
Print Quality options plotter quality levels
Draft Draft
Low Draft
Medium Final
High1 Enhanced1

1  The Enhanced quality level is only available when one of the HP DesignJet 600 or 650C 
plotters is the selected plotter type.

For example, if you want to plot with your plotter's Final quality level, 
select the Medium option for Print Quality.

To change the Print Quality setting, highlight another selection in the 
drop-down list box.

HP DesignJet, DesignJet 600, and DesignJet 650C Users

Each time you send a plot, the plotter's front panel quality level is 
changed to match this Print Quality setting. This means that anyone 
who 1) is networked to your plotter and 2) doesn't have a plotter driver
with a print quality setting will be affected by the front panel change 
caused by your plot. To avoid this problem, the affected users should 
always check the plotter's front panel quality level before plotting.

HP DraftMaster and DraftPro Plus Users

The driver's Final quality level corresponds to the Quality print quality 
level in these plotters.
HP 7600 Series Users

When using the 240D and 240E models, there's no difference between 
the Draft and Final quality levels.

2.3.2.2.2  Copies

The Copies setting allows you to produce up to 99 plots of each 
drawing. To change the Copies setting, type in a new number between 
1 and 99, inclusive.
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2.3.3  Setup dialog box

The title bar of this dialog box includes the name of the default plotter that's 
selected in the Printers dialog box in the Windows Control Panel.

The settings in this dialog box are global; they are the default values for all of 
your currently-running applications. If you prefer to make only local changes 
(affecting only your current application), you can change these settings in the 
Print Setup and Print dialog boxes instead.

This dialog box also gives you access to two other dialog boxes, User-defined 
Size (through an option in the Media Size drop-down list box) and Options 
(through the Options button), which are described in subsequent sections. Refer
to sections 2.3.4 and 2.3.5, "User-defined Size dialog box" and "Options dialog 
box," for more information.

2.3.3.1  Accessing

To access this dialog box from the Windows desktop, choose the Control 
Panel, choose Printers, then click the Setup button.

2.3.3.2  Changing the settings

This dialog box has five settings: Media Size, Media Source, Print Quality, 
Orientation, and Copies.
Orientation works the same way as the Orientation setting described 
previously in section 2.3.1, "Print Setup dialog box."
Copies works like the Copies setting described previously in section 
2.3.2.2.2, "Copies."
The Media Size, Media Source, and Print Quality settings are described 
below.
2.3.3.2.1  Media Size

The Media Size setting works very much like the Paper Size setting 
described in the previous section 2.3.1, "Print Setup dialog box." The 
only difference is in the way the "User-defined" option works.
In the Print Setup dialog box, you could select "User-defined" from the 
Paper Size drop-down list box, but you couldn't change its value. In the 
Setup dialog box, you can select and change the "User-defined" value.

When you select "User-defined" from the Media Size drop-down list 
box, the User-defined Size dialog box is displayed. Refer to section 
2.3.4, "User-defined Size dialog box," for more information.
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2.3.3.2.2  Media Source

The Media Source setting indicates whether you've loaded a single 
sheet or a roll of media in your plotter, and if a roll, the width.
To change the Media Source setting, highlight another selection in the 
drop-down list box. For example, if you've loaded a D-size roll, select 
"24 inch Roll."
NOTES: 1) If you've loaded a roll size that isn't displayed, choose 

"Sheet."
2) You must select a Media Source regardless of whether 

you have a sheet or a roll loaded.
2.3.3.2.3  Print Quality

The Print Quality setting indicates the quality level at which your plots 
will be produced (i.e., Draft, Final, or Enhanced). The Enhanced quality 
level is only available when one of the HP DesignJet 600 or 650C 
plotters is selected.
To change the Print Quality setting, highlight another selection in the 
drop-down list box.
HP DesignJet, DesignJet 600, and DesignJet 650C Users

Each time you send a plot, the plotter's front panel quality level is 
changed to match this Print Quality setting. This means that anyone 
who 1) is networked to your plotter and 2) doesn't have a plotter driver
with a print quality setting will be affected by the front panel change 
caused by your plot. To avoid this problem, the affected users should 
always check the plotter's front panel quality level before plotting.
HP DraftMaster and DraftPro Plus Users

The driver's Final quality level corresponds to the Quality print quality 
level in these plotters.
HP 7600 Series Users

When using the 240D and 240E models, there's no difference between 
the Draft and Final quality levels.
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2.3.4  User-defined Size dialog box

Use this dialog box instead of the other options in the Paper Size setting (Print 
Setup dialog box) or Media Size setting (Setup dialog box) when: 
> The dimensions of the media you've loaded are not listed among the other 

options,
OR

> You want to produce a long-axis plot. (Refer to section 3.2.4, "Long-axis 
plotting," for more information.)

2.3.4.1  Accessing

To access the User-defined Size dialog box, select "User-defined" (last 
option) from the Media Size drop-down list box in the Setup dialog box. (To 
access the Setup dialog box from the Windows desktop, choose Control 
Panel, choose Printers, then click the Setup button.)

2.3.4.2  Changing the settings

This dialog box has three settings: Units, Length, and Width.

When entering Width and Length values, refer to the following table for the 
range of acceptable values (inclusive), which are based on the plotter type 
you selected in this driver. The Length setting must always be greater than 
or equal to the Width setting.
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Driver-selected Width Length
Plotter Type1 Range Range2

HP DesignJet Plotters 8.3 to 36.1 in 8.3 to 109.2 in
(211 to 917 mm) (211 to 2773 mm)

HP DesignJet 600 Plotter (C2847A) 8.3 to 24.6 in 8.3 to 109.2 in
(211 to 625 mm) (211 to 2773 mm)

HP DesignJet 600 Plotter (C2848A) 8.3 to 36.1 in 8.3 to 109.2 in
(211 to 917 mm) (211 to 2773 mm)

HP DesignJet 650C Plotter (C2858A) 8.3 to 24.6 in 8.3 to 109.2 in
(211 to 625 mm) (211 to 2773 mm)

HP DesignJet 650C Plotter (C2859A) 8.3 to 36.1 in 8.3 to 109.2 in
(211 to 917 mm) (211 to 2773 mm)

HP DraftMaster Plotters (all) 8.2 to 36.5 in 8.2 to 109.2 in
(208 to 927 mm) (208 to 2773 mm)

HP DraftPro Plus Plotter (C3170A) 8.2 to 25.0 in 8.2 to 63.0 in
(208 to 635 mm) (208 to 1600 mm)

HP DraftPro Plus Plotter (C3171A) 8.2 to 36.2 in 8.2 to 63.0 in
(208 to 919 mm) (208 to 1600 mm)

Hewlett-Packard HP-GL/2 Plotter8.3 to 36.1 in 8.3 to 109.2 in
(211 to 917 mm) (211 to 2773 mm)

1  If you're using an HP 7550B Graphics plotter, you should only choose from the following 
Paper Sizes: 
ANSI A, ANSI B, ISO A3, and  ISO A4.
2  If your application has a maximum length value, your plots will be limited to that value even
if you enter a higher Length value in the driver. 
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2.3.4.2.1  Units

The Units setting indicates the units of the Length and Width 
dimensions you will enter (see below).

To select a Units setting, click the option button you want (Millimeters 
or Inches).

2.3.4.2.2  Width

The Width setting indicates either the width (shorter dimension) of the 
custom-size media you've loaded, or the width of the media you've 
loaded for a long-axis plot. 
To enter the Width setting, type a number in the units you selected 
above. 
NOTE: Always enter the shorter dimension for Width.

2.3.4.2.3  Length

The Length setting indicates either the length (longer dimension) of the
custom-size media you've loaded, or the length you want your long-
axis plot to be.
To enter the Length setting, type a number in the units you selected 
above.
NOTE: Always enter the longer dimension for Length.

2.3.5  Options dialog box

This dialog box is device-specific. If your selected plotter is one of the following 
devices (also called thermal inkjet or TIJ), the Options dialog box allows you to 
lighten or darken your plotted output with the Darkness setting. 
TIJ devices: HP DesignJet Plotter

HP DesignJet 600 Plotter (C2847A)
HP DesignJet 600 Plotter (C2848A)
HP DesignJet 650C Plotter (C2858A)
HP DesignJet 650C Plotter (C2859A)

NOTE: The TIJ devices listed above don't have pen parameter settings in the 
driver because they don't have pens in a carousel (they have pen 
cartridges) and they don't have the ability to plot in color. However, the
TIJ plotters can convert color in raster images to grayscale values. 
Refer to sections 3.1.3, "HP DesignJet plotter notes," and 3.1.4, "HP 
DesignJet 600 plotter notes," for more information.
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If your selected plotter is one of the remaining devices below, the Options 
dialog box allows you to change the Pen Number, Color, and Type settings.
Non-TIJ devices: HP DraftMaster SX Series

HP DraftMaster RX/MX Series
HP DraftPro Plus Plotter (C3170A)
HP DraftPro Plus Plotter (C3171A)
Hewlett-Packard HP-GL/2 Plotter

Refer to the appropriate section below for your selected plotter.
There are two ways to access the Options dialog box:
> Click the Options button in the previously-described Setup dialog box to 

make changes to the local Options settings,
OR

> Click the Options button in the previously-described Print Setup dialog box 
to make changes to the global Options settings. 

2.3.5.1 Options dialog box for TIJ devices

2.3.5.1.1  Darkness

The Darkness setting controls the lightness or darkness of your plotted 
output. You might find this setting useful if you're working with a 
scanned image in your application. 
The default Darkness setting is in the middle of the intensity bar. To 
choose another setting, click on another spot to the left (lighter) or 
right (darker) of the middle setting. There are five Darkness setting 
choices. To restore the default setting, click the Default button.

2.3.5.2 Pen Options dialog box for non-TIJ devices

Before using the settings in this dialog box, you may want to refer to 
your plotter's user guide for a table of pen colors and types available 
for your plotter type and media type (e.g., paper, vellum, polyester 
film).

This driver offers 8 Pen Numbers, 10 Colors, and many pen Types to 
choose from. The first time you open this dialog box, the default pen 
settings listed in the following table will be displayed. If you want to 
recover the defaults at any time after changing the pen settings, click 
the Default button.
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Pen Number Color Type
1 Black P.3
2 Blue P.3
3 Red P.3
4 Green P.3
5 Orange P.3
6 Brown P.3
7 Yellow P.3
8 Violet P.3

2.3.5.2.1  Pen Number 

Select a Pen Number to change its Color and/or Type. Or select multiple
Pen Numbers to change more than one Pen Number to the same Color 
or Type.  
To select a Pen Number, click it. If you click another Pen Number, the 
first one will remain selected. To deselect a Pen Number, click it again. 

2.3.5.2.2  Color

The Color setting lets you select a new color for the highlighted Pen 
Number(s). 
To change the Color setting, choose a new one from the Color menu. 
Choose from Black, Blue, Red, Green, Orange, Brown, Yellow, Violet, 
Red-violet, and Aqua.
Colors that aren't available for the selected pen Type are grayed, and 
can't be selected. When changing a pen's Color and Type, you may 
need to change the Type setting first.
How Color-Mapping Works

To decide which Pen Number will be selected for plotting, the driver 
compares the HLS (Hue, Lightness, and Saturation) value of the colored
object in your application to the HLS values of the driver's pen Colors. 
The colored object will be plotted with the driver pen Color that has the
closest HLS value. The plotted color may be very different  from the 
color you've selected in your application because 1) the driver has only
a few colors to select from, and 2) some applications don't accurately 
display the colors you've selected in your drawing.
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HP 7600 Series Users

For best color-mapping results, we recommend the following: 1) select 
"Plotter" (not "Software") as the source of pen parameters on the 
plotter's front panel, 2) define a new front panel pen palette with 8 
pens and assign only the front panel Color Numbers listed below, and 
3) assign the same Pen Number/Color settings to this driver, e.g., if Pen
Number 1 on the front panel is assigned to front panel Color Number 3 
(green), be sure that Pen Number 1 in the driver is also assigned to the
driver's Color green. 

Recommended  
7600 Front Panel Equivalent Driver's
Color Numbers Driver Color RGB Value
1 Black 0,0,0
2 Red 255,0,0
3 Green 0,255,0
4 Yellow 255,255,0
5 Blue 0,0,255
6 Red-violet 255,0,255
7 Aqua0,255,255
165 Brown 255,192,0
474 Orange 255,128,0
518 Violet 128,0,255

2.3.5.2.3  Type

The Type setting lets you choose a new type for the selected Pen 
Number(s).
To change the Type setting, choose a new one from the Type menu. 
Types that aren't available for the selected pen Color are grayed, and 
can't be selected. When changing a pen's Color and Type, you may 
need to change the Color setting first.
HP 7600 Series Users

The Type setting has no effect on these plotters.
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3.0  Helpful hints for plotting with this driver
Read the following sections to learn how to achieve the best quality and performance 
when plotting with this driver. These sections include plotter notes, application notes, 
and troubleshooting hints.

3.1 Plotter notes
After reading the first two sections about font support and margin settings (which 
apply to all plotter types supported by this driver), please read one of the 
subsequent sections about your plotter type. 
3.1.1 Font support and recommendations

The method of font generation the plotter uses depends on which Windows 
version you're using, which plotter you have, and which font you've selected in 
your document or drawing. 
For best plot results from most plotters, we recommend using any of the 
standard Windows vector fonts (Modern, Roman, and Script) in Windows 3.0 
and TrueType fonts in Windows 3.1. 

The only exception to the above recommendations applies to HP DesignJet 
650C users: when using these plotters with either Windows version, you can 
achieve best results with the standard Windows raster fonts (Courier, Helv, 
Symbol, System, Terminal, and Tms Rmn) and Adobe® Type Manager (ATM) 
fonts.
The following tables summarize this driver's font support for each version of 
Windows.

38



WINDOWS 3.0 FONT SUPPORT
Font Type Pen Plotters and Inkjet 
plotters
Selected Electrostatics (DesignJet,
in Document/ (All DraftMasters, DraftPro Plus, DesignJet 600, and
Drawing 7600 Series, and 7550B) DesignJet 650C plotters)
Any standard Windows Yes Yes
vector font
(Modern, Roman, Script)1

Any standard Windows Yes2 Yes
raster font
(Courier, Helv, Symbol, 
System, Terminal, Tms Rmn)3,4

Adobe Type Manager No Yes5

(ATM) fonts   4

TrueType fonts No6 No6

Intellifont Type fonts No No
(TypeDirector, 
Intellifont-for-Windows)
1 These fonts are recommended for Windows 3.0 users with all plotters except the HP DesignJet 
650C.
2  Plots using the plotter's internal stick fonts, which recreate the font characters on your computer 
screen by drawing them with a series of line segments. The stick font characters may be somewhat 
cruder-looking than the font characters you see on your computer screen. When plotting with these 
types of fonts, be sure to turn off Adobe Type Manager     (ATM)   or you won't get any font output at all.
3 When rotated using the pen plotters and electrostatics, these fonts will be converted to the 
plotter's internal stick fonts.
4 These fonts are recommended for Windows 3.0 users with the HP DesignJet 650C plotter.
5 With all plotters except the HP DesignJet 650C, multi-page documents plot very slowly and may 
appear to "hang up" the plotter. If this happens, try using one of the standard Windows vector fonts 
instead.
6 Windows 3.0 does not support TrueType fonts.
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WINDOWS 3.1 FONT SUPPORT

Font Type Pen Plotters and Inkjet 
plotters
Selected Electrostatics (DesignJet,
in Document/ (All DraftMasters, DraftPro Plus, DesignJet 600, and
Drawing 7600 Series, and 7550B) DesignJet 650C plotters)
Any standard Windows Yes Yes
vector font 
(Modern, Roman, Script)

Any standard Windows Yes1 Yes
raster font
(Courier, Helv, Symbol,
System, Terminal, Tms Rmn)2,3

Adobe Type Manager No Yes4

(ATM) fonts3

TrueType fonts2,5 Yes Yes

Intellifont Type fonts No No
(TypeDirector,
Intellifont-for-Windows)
1 Plots the Arial font, a TrueType, sans serif font. When your files have these standard Windows 
raster fonts in them, be sure to turn off Adobe Type Manager     (ATM)   or you won't get any font output
at all.
2 When rotated using the pen plotters and electrostatics, these fonts will be converted to the 
plotter's internal stick fonts.
3 These fonts are recommended for Windows 3.1 users with the HP DesignJet 650C plotter.
4 With all plotters except the HP DesignJet 650C, multi-page documents plot very slowly and may 
appear to "hang up" the plotter. If this happens, try using a TrueType font or one of the standard 
Windows vector fonts instead.
5 These fonts are recommended for Windows 3.1 users with all plotters except the HP DesignJet 
650C.

3.1.1.1 Note to ATM font users (version 2.5 only)

Use the instructions below to change one of the default selections in the 
ATM Control Panel; if you don't, bitmapped text may not be plotted, or 
objects may be misplaced in your plots.

Step 1. Open the ATM Control Panel in Windows.

Step 2. Click on the check box next to "Print ATM fonts as graphics;" an "X"

should appear in the box to indicate that this option is now 
selected.

Step 3. Click the Exit button to exit the ATM Control Panel.
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3.1.2 Plotter margin settings using this driver

The following table lists the margin settings for each plotter type when using 
this driver. Some of the margin settings are different when you're not using this
driver. For best plotting results, make sure the margin settings in your 
application match the driver's margin settings for the selected plotter type. 
Also, be sure to read the "Special Case" section following the table.

Plotter type Driver
selected in this driver Margin settings
HP DesignJet Plotters Top and bottom = 17.0 mm (.67 in)

Left and right = 5.0 mm (.20 in)

HP DesignJet 600 Plotters Top and bottom = 17.0 mm (.67 in)
Left and right = 5.0 mm (.20 in)

HP DesignJet 650C Plotters Top and bottom = 17.0 mm (.67 in)
Left and right = 5.0 mm (.20 in)

HP DraftMaster SX Series Plotters Top, left, and right = 17.0 mm (.67 in)
Bottom = 41.0 mm (1.6 in)

HP DraftMaster RX/MX Series Plotters Top, left, and right = 17.0 mm (.67 in)
Bottom = 41.0 mm (1.6 in)

HP DraftPro Plus Plotters Top, left, and right = 15.0 mm (.59 in)
Bottom = 39.0 mm (1.5 in)

Hewlett-Packard HP-GL/2 Plotter (see paragraph and table below)
(driver selection for the HP 7550B 
Graphics Plotter and the HP 7600 
Series Plotters)

The "Hewlett-Packard HP-GL/2 Plotter" selection is a special case. It has 
different margin settings depending on which paper size and orientation are 
used. Refer to the table below; when a paper size other than the four sizes 
listed below is used, the margin settings are all 0 mm.

Orientation
Setting ANSI A, ISO A4 ANSI B, ISO A3
in driver paper loaded paper loaded
Landscape Top = 5.1 mm (.20 in) Top = 13 mm (.52 in)

Bottom = 16 mm (.62 in) Bottom = 13 mm (.52 
in)

Right = 13 mm (.52 in) Right = 5.1 mm (.20 in)
Left = 13 mm (.52 in) Left = 16 mm (.62 in)

Portrait Top = 13 mm (.52 in) Top = 5.1 mm (.20 in)
Bottom = 13 mm (.52 in) Bottom = 16 mm (.62 in)
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Right = 16 mm (.62 in) Right = 13 mm (.52 in)
Left = 5.1 mm (.20 in) Left = 13 mm (.52 in)
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3.1.2.1 SPECIAL CASE: For users who want to produce a landscape 
plot with the 

largest media size their plotter supports

This special case requires that you reverse the above indicated margins as 
follows: the top margin should be entered as the right margin and vice 
versa, and the bottom margin should be entered as the left margin and vice
versa. 

For example, if you have an E-size DesignJet 600 plotter and you want to 
produce an 
E-size plot in landscape orientation, you would enter the following margin 
settings:

Top = 5.0 mm (.20 in)
Bottom = 5.0 mm (.20 in)
Left = 17.0 mm (.67 in)
Right = 17.0 mm (.67 in)

3.1.3 HP DesignJet plotter notes

When using one of these plotters, please keep the following notes in mind:

* Always select pen parameter source = "Software."

Be sure to set the front panel's source of pen parameters to "Software" to 
ensure that this driver will work correctly.

To check the plotter's front panel setting, select "Source" from the Pen 
Parameters menu. If the front panel says, "Source=Software," you don't 
need to change anything. If it says anything else, press Enter, use Down 
Arrow to scroll to "Software," then press Enter.

* Colored objects are plotted with gray values.

Because the source of pen parameters is always set to "Software" when 
using this driver, the driver will convert a colored object to black or to one 
of the plotter's nine shades of gray based on the HLS (Hue, Lightness, and 
Saturation) value of the color selected in your software application. The 
plotter's front panel pen settings are ignored.

The available gray values in percentages of black are: 10%, 20%, 30%, 
40%, 50%, 60%, 70%, 80%, 90%, and 100% (black).

* Rasterized drawings can't be rotated from the plotter's front 
panel.

Due to rotate buffer memory limitations, rasterized drawings (e.g., 
drawings with heavy area fill and shading that you've scanned into your 
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application) can't be rotated using the front panel Rotate feature. If you 
want to rotate a plot that contains rasterized data, we recommend rotating 
it from within your application.

NOTE: If you're running Windows 3.1, one way to tell if you have 
rasterized data in your plot is if you have used Object Linking and 
Embedding (OLE).

3.1.4 HP DesignJet 600 and DesignJet 650C plotter notes 

When using one of these plotters, please keep the following notes in mind:
* Always select pen parameter source = "Software."

Be sure to set the front panel's source of pen parameters to "Software" to 
ensure that this driver will work correctly.
To check the plotter's front panel setting, select "Palette" from the Pen 
Settings menu. If the front panel says, "Palette=Software," you don't need 
to change anything. If it says anything else, press Enter, use Down Arrow
to scroll to "Software," then press Enter.

* Colored objects are plotted with gray values (DesignJet 600 only).
Because the source of pen parameters is always set to "Software" when 
using this driver, the driver will convert a colored object to black or to one 
of the plotter's nine shades of gray based on the HLS (Hue, Lightness, and 
Saturation) value of the color selected in your software application. The 
plotter's front panel pen settings are ignored.

The available gray values in percentages of black are: 10%, 20%, 30%, 
40%, 50%, 60%, 70%, 80%, 90%, and 100% (black).

* Rasterized drawings can't be rotated from the plotter's front 
panel.

Due to rotate buffer memory limitations, rasterized drawings (e.g., 
drawings with heavy area fill and shading that you've scanned into your 
application) can't be rotated using the front panel Rotate feature. If you 
want to rotate a plot that contains rasterized data, we recommend rotating 
it from within your application.
NOTE: If you're running Windows 3.1, one way to tell if you have 

rasterized data in your plot is if you have used Object Linking and 
Embedding (OLE).

* The autorotate feature is disabled.
The HP DesignJet 600 and 650C plotters have an automatic rotation feature
that rotates plots on roll media when rotating will conserve media. The 
autorotate feature is disabled when you use this plotter driver.
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* Expanded margins are not available.
The HP DesignJet 600 and 650C plotters have an Expanded margin feature 
that increases the plottable area. When you use this driver, the Expanded 
margin feature is not available.
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3.1.5 HP DraftMaster SX/RX/MX Series and HP DraftPro Plus plotter notes

When using one of these plotters, please keep the following notes in mind:
* Expanded margins are not available.

The HP DraftMaster and DraftPro Plus plotters have an Expanded margin 
feature that increases the plottable area. When you use this driver, the 
Expanded margin feature is not available.

* Always select Drawing Size = "Soft."

Be sure to set the front panel's Drawing Size to "Soft" to ensure that this 
driver will work correctly.
To change the front panel setting, press the Page Format button, select 
"Drawing Size," then scroll to "Soft" and press the Enter button.

* Pen width accuracy is best up to .35 mm.
For best accuracy, use only pens up to 0.35 mm wide. When used with this 
driver, larger pen widths may not meet the accuracy specifications stated 
in the HP DraftMaster User's Guides.

* Rasterized patterns are converted to solid fills (HP DraftMaster 
Series plotters only).

If your drawing has an object with a rasterized pattern, it will be plotted as 
a solid fill.

* When you rotate TrueType fonts and standard Windows raster 
fonts (Courier, Helv, Symbol, System, Terminal, Tms Rmn), they're 
converted to the plotters internal stick fonts.

Some applications allow you to rotate text. However, if you're using one of 
these plotters and one of these fonts, the rotated text will be converted to 
the plotter's internal stick fonts.

* Make sure the Widelines feature is "ON" (HP DraftMaster Series 
plotters only)

The front panel of these plotters has a Widelines feature that you can 
access through the Plotter Setup menu. For best line-plotting results, this 
feature should always be turned on. If this feature is turned off, your 
plotted lines will be narrower than the widths you specified in your 
application.
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If you're using an SX or RX model: press the Plotter Setup button, select 
Widelines, scroll to ON, then press Enter. 

If you're using an MX model: Press the Plotter Setup button, select 
Widelines, specify the user for whom you want to turn on the Widelines 
feature, press Enter, scroll to ON, then press Enter again.

* Fill pattern background colors aren't plotted (HP DraftMaster 
Series plotters only).

Only a foreground color will be plotted when using one of these plotters. 
The background color will look like a white fill.

3.1.6 HP 7550B Graphics plotter notes
* When installing this driver, be sure to select "Hewlett-Packard HP-

GL/2 Plotter" as the plotter type.

* Rasterized patterns are converted to solid fills.

If your drawing has an object with a rasterized pattern, it will be plotted as 
a solid fill.

* When you rotate TrueType fonts and standard Windows raster 
fonts (Courier, Helv, Symbol, System, Terminal, Tms Rmn), they're 
converted to the plotters internal stick fonts.

Some applications allow you to rotate text. However, if you're using one of 
these plotters and one of these fonts, the rotated text will be converted to 
the plotter's internal stick fonts.

* Only four media sizes are available.

You should only choose from the following Media Sizes: ANSI A, ANSI B, ISO 
A3, and ISO A4.

* Make sure the Widelines feature is "ON."

The front panel of these plotters has a Widelines feature. For best line-
plotting results, this feature should always be turned on. If this feature is 
turned off, your plotted lines will be narrower than the widths you specified 
in your application.

To verify that Widelines is turned on: Press Next Display until Wideline 
appears, press Wideline, press f4 until Wideline is toggled into the "ON" 
position, press Enter, then press Next Display.
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* Fill pattern background colors aren't plotted.

Only a foreground color will be plotted when using one of these plotters. 
The background color will look like a white fill.

3.1.7 HP 7600 Series plotter notes

When using one of these plotters, please keep the following notes in mind:
* This driver limits support to vector data only: raster data (RTL) is 

not supported.

* When installing this driver, be sure to select "Hewlett-Packard HP-
GL/2 Plotter" as the plotter type.

* Follow these recommendations for best color-mapping results:

1) Select "Plotter" (not "Software") as the source of pen parameters on the 
plotter's front panel. 
2) Define a new front panel pen palette with 16 pens and choose from the 
front panel Color Numbers listed below.
3) Assign the same Pen Number/Color settings to this driver, e.g., if Pen 
Number 1 on the front panel is assigned to front panel Color Number 3 
(green), be sure that Pen Number 1 in the driver is also assigned to the 
driver's Color green. 

Recommended  
7600 Front Panel Equivalent Driver's
Color Numbers Driver Color RGB Value
1 Black 0,0,0
2 Red 255,0,0
3 Green 0,255,0
4 Yellow 255,255,0
5 Blue 0,0,255
6 Red-violet 255,0,255
7 Aqua0,255,255
165 Brown 255,192,0
474 Orange 255,128,0
518 Violet 128,0,255

* Rasterized patterns are converted to solid fills.

If your drawing has an object with a rasterized pattern, it will be plotted as 
a solid fill.
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3.2 Software application notes
3.2.1 AutoCAD Release 11/12 for Windows users: use the Autodesk driver 

instead of this one

When using AutoCAD Release 11/12 for Windows, we recommend plotting with 
the Autodesk driver that was automatically loaded when you installed AutoCAD.
Follow the steps below to ensure that you've selected the recommended driver 
in AutoCAD.

Step 1. From the AutoCAD main menu, choose "Configure AutoCAD" from the 
Utilities menu.

Step 2. Read the text to the right of "Plotter." If it says, "Hewlett-Packard HP-
GL/2 V1.0 ADI 4.1 - By Autodesk," the plotter configuration is correct 
and you don't need to do anything else; if it says something different, 
continue with the next step.

Step 3. Press Enter and type 5 to select "Configure plotter."

Step 4. Type Y to the question, "Do you want to select a different one?," and 
type 6 to select "Hewlett-Packard HP-GL/2 V1.0 ADI 4.1 - By Autodesk."

Step 5. Answer any remaining questions and return to the main menu. Be sure 
to save the configuration changes you just made.

3.2.2 Users of paint and image-processing applications 
(such as Aldus PhotoStyler, Publisher's Paintbrush)

Because of the large amount of data involved, plotting large-format raster 
images (such as scanned images) will proceed slowly.

3.2.3 Some applications have an overriding orientation setting

The following table lists some commonly-used applications with their own 
orientation setting that overrides the driver's Orientation setting. (In 
applications, the orientation setting can usually be found by selecting Page 
Setup, Print, or a similarly-named command from the File menu.) When using 
these and other applications with an orientation setting, you should match the 
driver's Orientation setting to the orientation setting in the application. 
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Some applications with an overriding orientation setting
CorelDRAW
Microsoft Excel for Windows
Microsoft Word for Windows

3.2.4 Long-axis plotting

The long-axis feature allows you to produce plots up to 109.2 inches (2773 mm)
long with this driver. Long-axis plotting is possible if both the plotter and the 
application support this feature.

All the supported plotters except the HP 7550B support long-axis plotting. The 
HP DraftPro Plus supports long-axis plotting, but long-axis plots are limited to 
63.0 inches (1600 mm).

Below is a list of some commonly-used Windows applications that support long-
axis plotting. If your application isn't in this list, refer to your application user's 
guide to find out if long-axis plotting is supported.

Some applications that support long-axis plotting
Arts & Letters
CADVANCE
Micrografx Designer
Microsoft Project*

*  Although this application supports long-axis plotting, plot length is limited to 62 inches (1575 
mm).

To produce a long-axis plot, you must enter the long-axis plot Length in the 
User-defined Size dialog box. 

NOTE: Your application may require other setting changes as well; refer to 
your application user's guide for more information.

To access the User-defined Size dialog box in Windows 3.0, choose the Control 
Panel from the Windows Main Group, choose Printers, click the Configure 
button, click the Setup button, then select the last option in the Media Size 
drop-down list box, "User-defined." 

To access the User-defined Size dialog box in Windows 3.1, choose the Control 
Panel from the Windows Main Group, choose Printers, click the Setup button, 
then select the last option in the Media Size drop-down list box, "User-defined."

3.2.5 CorelDRAW users

If you're using CorelDRAW with this driver, you can only produce A- and B-size 
plots from a TIFF drawing.

50



3.2.6 Excel users with DesignJet Series plotters

When you want multiple copies of a plot, we recommend using the DesignJet's 
front panel to set the number of copies you want instead of using the Excel 
print dialog box. Refer to your DesignJet plotter user's guide for instructions.

3.2.7 Microsoft Project users

The default margins in Microsoft Project's Page Setup dialog box are too small 
for the plotters this driver supports. To remedy this problem, we recommend 
that you refer to the table in section 3.1.2 of this document and enter the 
margins for your plotter type into Microsoft Project's Page Setup dialog box.

3.2.8 Lotus 1-2-3 users

When specifying more than one text color in a spreadsheet, we recommend 
that you only use a white background. If you try to shade the background with a
different color than white, you may not get the color you want when using this 
driver.
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3.3 Troubleshooting
This section lists some common problems and their solutions.
* If the top and/or bottom of plots is missing (clipped)

1) Make sure the driver's Media Size setting is exactly the same as the drawing 
size you've specified in your application.
OR
2) Do one of the following: a) Adjust the margin settings in your application to 
match the driver's margin settings for the selected plotter type (see section 
3.1.2, "Plotter margin settings using this driver"), or b) scale down the size of 
the drawing in your application, or c) increase the Media Size driver setting and
load a larger media size.

* If the driver's Orientation setting seems to have no affect on plots

Your application may have an orientation setting that overrides the Orientation 
setting in this driver. We know that the following applications work this way, 
and there may be others as well: Microsoft Excel for Windows, Microsoft Word 
for Windows, and CorelDRAW. Be sure to match the driver's Orientation setting 
to the application's orientation setting.

* If plotting text produces unexpected results

Refer to section 3.1.1, "Font support and recommendations," to learn about this
driver's font support for each version of Windows and each plotter type.

* If plots won't rotate using the plotter's front panel Rotate feature 
(HP DesignJet and HP DesignJet 600 plotter users only)

Your plot may have rasterized data in it. Due to rotate buffer memory 
limitations, rasterized drawings (e.g., drawings with heavy area fill and shading 
that you've scanned into your application) can't be rotated from the plotter's 
front panel. Try using your application's rotate feature.
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* If your plotter is unusually slow or appears to be "hung up"

1) Make sure you're using the recommended font type for your version of 
Windows. Refer to section 3.1.1, "Font support and recommendations," for more
information. Multi-page documents plot very slowly and may appear to "hang 
up" the plotter. If this happens, try using one of the TrueType fonts (available in 
Windows 3.1 only) or one of the standard Windows vector fonts instead.
AND
2) Check the Orientation and Media Size settings in the driver. If you're plotting 
in landscape mode on the largest media size of your plotter, plotting may be 
very slow. If you want to plot faster, change the driver's Orientation setting to 
portrait, and rotate the drawing 90 degrees in your application.

* If your computer displays a timeout message before all plot data has 
been received by the plotter

Try increasing the Transmission Retry value to 900 seconds. To access this 
setting In Windows 3.0, choose Control Panel, Printers, then Configure. To 
access this setting in Windows 3.1, choose Control Panel, Printers, then 
Connect.

* If filled and overlapping objects are plotted incorrectly
(HP DesignJet and HP DesignJet 600 plotters only)

Only the HP DesignJet 600 plotters are capable of plotting both rasterized data 
and  overlapping objects correctly all the time. The HP DesignJet plotters are 
raster-capable, but they can't plot overlapping objects correctly and they have 
more raster limitations than the later-model HP DesignJet 600 plotter.

* If filled and overlapping objects aren't plotted the way you expected
(HP DraftMaster series plotters, HP DraftPro Plus plotters, and HP 
7550B Graphics plotters only)

Pen plotter technology doesn't allow merge control of filled, overlapping 
objects. If you have two (or more) overlapping objects in your drawing, the 
intersecting area will be plotted with the fill patterns from all intersecting 
objects. 

* If polygon objects are incompletely plotted
(HP DraftMaster series plotters and HP 7550B Graphics plotters only)

You probably ran out of polygon buffer memory before the plot was finished. Try
shrinking the size of the object before plotting again.
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* If the plotter is drawing a filled object and performance seems 
unacceptably slow
(HP DraftMaster series plotters and HP 7550B Graphics plotters only)

When filled objects have outside borders with wide line widths, these plotters 
may perform more slowly. Try reducing the border to the smallest acceptable 
line width to improve performance.

* If the plotter you want to use isn't displayed in the Windows 3.1 
Control Panel (Printers dialog box)

Run the driver's install program again and select the new Plotter type. Refer to 
section 1.2, "Installing with the driver's quick "install" program (recommended 
method)," for instructions.

* If the driver settings have unexpectedly changed back to their default 
values

You may have changed the Port assignment for the selected plotter. If so, the 
driver settings you made are saved with the previous Port selection. You can 
either make the setting changes again, or change back to the previous Port.

* If plotted colors look different than expected 
(HP DraftMaster SX/RX/MX Series, HP 7600 Series, and HP 7550B 
plotters only)

This driver doesn't provide exact color matching. When using one of the HP 
7600 Series plotters, follow the recommendations in section 3.1.7, "HP 7600 
Series plotter notes."

* If the plotted drawing size is smaller than the driver's Media Size 
setting

1) Make sure that the driver's Media Size setting is exactly the same as the 
drawing size you've specified in your application.
AND
2) Your application may have a maximum plot size limit. If so, your drawing will 
be truncated at the limiting dimensions. For example, CorelDRAW limits 
drawings to 18.0 x 18.0 inches (457 x 457 mm); if you specify a larger Media 
Size in the driver - "ANSI E 34 x 44 in," for example - your 18.0 x 18.0-inch 
drawing will be plotted in one corner of the E-size media.
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* If plotted gray shades look different than expected 
(HP DesignJet and HP DesignJet 600 plotters only)

Make sure the source of pen parameters is set to "Software" on the plotter's 
front panel. Refer to section 3.1.3, "HP DesignJet plotter notes," or section 
3.1.4, "HP DesignJet 600 plotter notes," for instructions.

* If the plotter's Expanded margin feature doesn't work 
(HP DesignJet 600 and HP DraftMaster plotter users only)

This driver doesn't support the Expanded margin feature.

* If pattern fills aren't being plotted
(HP DraftMaster Series plotters, HP DraftPro Plus plotters, and HP 
7550B Graphics plotters only)

The pattern fill (e.g. cross-hatching) you selected in your application is a raster 
pattern. Since pen plotter technology doesn't allow output of raster patterns, 
your pattern won't plot and it will look like the object has a solid fill. We 
recommend changing the pattern to a solid color in your application before 
plotting again.

* If the background color of a pattern fill isn't being plotted
(HP DraftMaster series plotters, HP DraftPro Plus plotters, and HP 
7550B Graphics plotters only)

Only a foreground color will be plotted when using one of these plotters. The 
background color will be a white fill.

* If plotted lines don't have the expected widths
(HP DraftMaster Series plotters and HP 7550B Graphics plotters only)

Turn on the Widelines feature on the front panel of your plotter, then try 
plotting again.

If you're using a DraftMaster SX or RX model: Press the Plotter Setup button, 
select Widelines, scroll to ON, then press Enter. 

If you're using a DraftMaster MX model: Press the Plotter Setup button, select 
Widelines, specify the user for whom you want to turn on the Widelines 
feature, press Enter, scroll to ON, then press Enter again.

If you're using an HP 7550B plotter: Press Next Display until Wideline 
appears, press Wideline, press f4 until Wideline is toggled into the "ON" 
position, press Enter, then press Next Display.
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4.0  Getting Help
Both on-line Help and customer service help are available for this driver.

4.1  On-line Help
If you need help while setting up your driver, you can access the on-line Help topics 
for the driver by clicking the Help button in the driver dialog boxes described in this 
document. 

To display a topic, click it. To print, select Print Topic from the File menu. 

4.2  Customer support
If you find that you have questions about the driver while you are installing it or 
setting it up, you can call the HP Customer Support Center for help in the United 
States.

HP Customer Support Center
7 a.m.-4 p.m. (Mountain Standard Time)
Monday through Friday
(208) 323-2551

Outside of the United States, contact your local authorized Hewlett-Packard dealer 
for customer support.
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